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Veevõrgu kalibreerimine (EPANET) 

Antud tunnis vaadatakse põgusalt kalibreerimise aspekte veevõrgumudelis. Tähelepanu pööratakse 
mõõtmistulemuste kaasamisele EPANET tarkvarasse ning vaadatakse ka võimalikke standard-
töövahendeid, kuidas ühte lihtsat kalibreerimist läbi viia.  

Siiani oleme vaadanud mudelid, kus tegemist on uute torustikega, ning kõik parameetrid seega teada 
ning arvutustulemusi on suhteliselt lihtne läbi viia. Samas tuleb läbi viia ka torustike rekonstruktsiooni-
projekte, mis kaasavad endas ka olemasolevaid torustikke.  
 
Perfektsed andmed  
Esimene näide (anytown_perfektne_start) vaatleb veevõrgumudelit, kus on sooritatud 4-s punktis 
mõõtmised (5 erineval ajahetkel) ning need on salvestatud faili. EPANET tarkvarasse on võimalik sisse 
lugeda mõõtmistulemusi, et neid võrrelda mudelist saadutega. See ongi kalibreerimise esmane etapp. 
Mõõtmistulemuste andmefail omab teatud kuju, mis on alljärgnev:  

-----Fail mootmised_perfektne_lekketa.dat algus-----  

 
-----Fail mootmised_perfektne_lekketa.dat lõpp---- 

Fail sisaldab endas esimeses veerus elemendi ID-d, teises veerus on toodud ajahetke väärtused ning 
kolmandas mõõtmistulemused vastavates punktides. Analoogne failistruktuur on mistahes 
mõõtmisandmete sisselugemiseks EPANET tarkvarasse. Antud juhul on tegemist rõhu mõõtmistega 
vastavates punktides, mis on üks levinumaid mõõteandmete tüüpe (vooluhulkade kõrval), mida 
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kalibreerimise juures kasutatakse. Ehkki faili originaallaiend on *.dat lõpuga, võib faili salvestada ka 
*.txt laiendiga (lihtsalt hiljem faili määratlemisel tuleb võtta säte All Files).  

Veevõrgumudel (esitatud alloleval pildil) sisaldab kolme pumpa (üksteise peale joonistatud, vaata 
Browser akent), kahte mahutit, 16 sõlme ning 34 toru.  

 

Kuna mõõtmised on veevõrgus tehtud, ning salvestatud eraldi faili, siis laeme selle EPANET tarkvara 
sisse. Menüüst Project > Calibration Data....Dialoogis Calibration Data loeme varem salvestatud 
mõõtmistulemuste faili sisse reale Pressure, klikkides nupul Browse ning otsides vastava faili üles.  

Järgmine etapp on mõõtmistulemuste kontroll mudelis arvutatud väärtustega. Selleks kliki Run, 
veendu, et mudel töötab korrektselt ning vali menüüst Report > Calibration. Avanevas dialoogis on 
automaatselt valitud Pressure mõõtmistulemustena ning lisaks eelvalitud ka failist leitud sõlme ID-d. 
Jäägu kõik sõlmed valituks. Seejärel kliki OK.  
 
Avaneb dialoog: Calibration Report – Pressure.  

 

See dialoog sisaldab endas kolme paani. Need kõik on informatiivse sisuga. Esimene paan Statistics 
näitab arvuliselt mõõtetulemuste ning arvutustulemuste erinevusi. Teine paan Correlation Plot esitab 
graafiku (vaata allolevat pilti).  
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Graafikult on hea näha, kui suured erinevused on mõõtmistulemuste ja arvutustulemuste vahel. 
Ideaalolukord eeldab, et ristikesed asuksid 45 kraadi joonel. Meil antud juhul on kõik punktid sellest 
ülal pool.  

Viimane paan Mean Comparisons esitab tulpdiagrammina mõõtmis- ning arvutustulemuste vahelised 
erinevused. 

 

Vaatame uuesti graafikut. Ehkki meil on vaid neli mõõtmispunkti, esitakse graafikul iga mõõte/arvutus 
tulem iga ajahetke kohta. Seega on meil kokku [4 punkti] x [5 ajahetke] = 20 punkti.  

EPANET tarkvara ei sisalda endas kalibreerimismoodulit, mis võimaldaks meil automaatselt mudelit 
kalibreerida. Eelpooltoodud töövahendid on vaid protsessi kirjeldamiseks. Seega tuleb meil 
kalibreerida mudel nö käsitsi. Milles väljendub kalibreerimine? Enamjaolt on selleks torud/sõlmede 
karakteristikute muutmine nii, et mõõtmistulemused klapiksid arvutuslike tulemustega. Samas võib 
kohe öelda, et tõeseid tulemeid võib olla mitmeid ja mitmed. Seda just seetõttu, et tavaliselt on meil 
mõõtmispunkte oluliselt vähem kui veevõrgu sõlmi. See tingib ka asjaolu, kus iga mõõtmispunkt tuleks 
hoolikalt enne paika panna. Mõõtmispunkti valikust sõltub see, kui palju kasulikku infot mudeli jaoks 
on meil võimalik saada.  
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EPANET tarkvara töövahendeid kasutades kalibreerime oma mudeli. Graafikut vaadates paistab meile 
esimese asjana silma, et kõik punktid asuvad ülal pool 45 kraadi joont. Arvutuslikud rõhud mudelis on 
märksa suuremad kui mõõdetud. See tähendab loomulikult seda, et me peame kuidagiviisi 
rõhukadusid suurendama, mis on ka vanemate veetorustike iseloomulikemaid jooni. Rõhukadu saame 
suurendada muutes torustike karedust. Hetkel on kõikide torude karedused võrdsed väärtusega 0.1 
mm (Darcy-Weisbach).  

Meil on tegemist suhtelise lihtsa näitega, ning eeldame, et kõik torud omavad ühte ja sama karedust. 
EPANET tarkvaras saab väga lihtsalt teatud grupi elementide parameetreid korraga vahetada 
alljärgneval viisil: 
 

1) Valime töövahendi Select Region. 
2) Tirime ümber oma mudeli valikuakna (vasaku hiire nupuga klikkides). Seejärel parem klikk 

valikuakna sulgemiseks. 

 

3) Seejärel valime menüüst Edit > Group Edit... Avaneb dialoog Group Edit, kus teeme vastavad 
muudatused: 

 

• Real For all valime Pipes.  
• Alumise rea vasakust hüpikmenüüst valime operatsiooni, mida soovime teha: Replace 

(soovime asendada hetke toru kareduse uuega). 
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• Parameetriks on *Roughness.  
• Real with sisestame väärtuseks 1 (toru karedus seega 1 mm).  
• Kliki OK.  
• Kuvatakse dialoog, mitme elemendi parameeter õnnestus muuta.  

 

• Kliki OK.  

Kõikide torude kareduse parameeter on nüüd muudetud. Käivitame mudeli uuesti ja kontrollime nüüd 
kalibreerimise graafikut (mõõtmistulemuste faili ei pea uuesti valima, see on meil endine).  

 

Graafik on märksa parem. Ehkki on seda suhteliselt raske analüüsida, kui eelnevat ees pole. Samas kui 
vaadata paani Statistics, siis sealt leiame, et üle üldine korrelatsioon on suurenenud 0.982 > 0.990. 
Samas on aga arvutuslike ning mõõdetud rõhkude vahe endiselt samas suurusjärgus. Täpsemalt öeldes 
rõhkude erinevus on isegi üle 10m. See tähendab, et me oleme küll õigel teel, ent antud karedus on 
endiselt liiga väike esitamaks tegelikku olukorda. Kordame protseduuri (1) – (3) ning anname nüüd 
kõikide torude kareduseks väärtuse 5 mm.  

Vaadates kokkuvõtet kalibreerimise raportist, näeme, et korrelatsioon on veelgi kasvanud ning nüüd 
omab väärtust 0.998. Samas rõhkude vahe on endiselt kohati isegi 5m. Kordame protseduuri (1) – (3) 
ning anname nüüd kõikide torude kareduseks 9mm.  

Sedakorda on tegemist juba hea tulemusega. Korrelatsioon on 1.000 ning vahe mõõdetud ning 
arvutatud rõhkude vahel alla 1m. Samas paneme tähele, et endiselt oleks justkui ruumi karedust 
suurendada. Teeme seda. Sedakorda anname toru kareduseks 11mm. Paanil Statistics justkui midagi 
ei muutukski. Seda seetõttu, et Mean Error on võetud absoluutväärtusest. Samas kui vaadata paani 
Correlation Plot, siis näeme, et meie punktid asuvad nüüd kõik allpool 45 kraadi joont. Seega võib teha 
järelduse, et pingutasime veidi üle. Teeme veel ühe muudatuse, sedakorda anname torude kareduseks 
10 mm.  



WATER | Veevõrgu kalibreerimine (EPANET) | Raido Puust | 2024 6/12 
 

Vaadates kalibreerimise raporti paani Statistics ei oskaks paremat tulemust lausa lootagi. Viga on vaid 
loetud millimeetrid. Graafik oleks samuti perfektne ning loomulikult esitab paan Mean Comparisons 
ka väga hea tulemi. Oleme jõudnud punkti, kust enam paremaks minna ei saa.  

Kuna tegemist oli tehislikult loodud näitega, kus mõõtmistulemused olidki võetud EPANET mudeli 
olukorras, kus torude karedused on 10 mm, siis oli tegelikult lõpptulem ette teada. Samas tegelikkuses 
pole aga nii ideaalseid olukordi olemas.  

Järgmises osas vaatame märksa realistlikumat olukorda, kus mõõtmisandmetel on teatud viga juurde 
liidetud.  

Näite lõpp. 

 
Mõõtmisveaga andmed 
Mõõtmised veevõrgus tehakse teatud täpsusega ning alati esinevad teatud süstemaatilised vead. 
Samas võivad mõõtmisvead esineda väga erinevates võrguosades. Näiteks üks sagedasemaid on 
sõlmpunktide kõrgusmärkide vale sisestamine, mis võib muuta drastiliselt mudeli ning 
mõõtmistulemite vahelisi erinevusi. Meie eesmärk pole antud ülesandes hinnata viga, vaid kasutada 
teadlikult veidi muudetuid andmeid nägemaks, kuidas see meie kalibreerimise protseduuri muudab.  

Ava fail: anytown_vead_start.net.  

Lae rõhumõõtmiste fail mootmised_vead_noise_lekketa.dat. Käivita mudel ning analüüsi tulemit 
menüüvaliku Report > Calibration kaudu. Esimeselt paanilt Statistics näeme, et korrelatsioon on 0.987 
ning erinevus mõõdetu ning arvutatu vahel kõigub 5 ja 11.5 meetri vahel. Tegemist on jällegi üsna 
suurte erinevustega, sest meie mudel sisaldab algselt nn uusi torusid, kus karedus on viidud 
minimaalseks (0.1 mm). Graafikult Correlation Plot näeme, et jällegi on kõik arvutuslikud väärtused 
suuremad mõõdetud väärtustest, mis tähendab loomulikult seda, et karedusi tuleb suurendada. 
Eeldades, et kõikides torudes on üks ja seesama karedus, anna uueks kareduseks esmalt 5 mm.  

Analüüsides lõpptulemust näeme, et korrelatsioon on 1.000 ning mõõdetud ning arvutuslike rõhkude 
vahe on oluliselt vähenenud. Suurendame karedust veelgi. Nüüd kõikidele torudele 7 mm.  

Vaadates lõpptulemust näeme, et nüüdne viga on kõige suurem sõlmes 120, mis on ligikaudu 10 cm. 
Antud tulemit võib pidada üsna heaks.  
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Siiski võime proovida suurendada karedust näiteks 8 mm. Vaatame mis juhtub. Analüüsides tulemit, 
näeme, et olukord on eelnevast kehvem. Seda võis aimata ka eelnenud tulemist, kus toru karedused 
olid 7 mm. Nimelt veeru Computed Mean summaarne väärtus oli juba siis väiksem kui veeru Observed 
Mean summaarne väärtus. Loomulikult suurendab kareduse tõstmine nende vahet samas suunas 
veelgi. Kui aga kontrollida näiteks karedust 6 mm. Siis on tegemist vastupidise olukorraga ning 
eeldades, et karedustäpsus on 1 mm, annab parima tulemi meile just 7 mm.  

Pane tähele, et eelmises näite lõpptulemuse juures olid märksa väiksemad vead arvutusliku ning 
mõõdetud tulemi vahel. Seda tingis asjaolu, et siis olid kasutusel perfektsed andmed. Antud juhul 
kasutasime mõõtmistulemuste juures juhusliku viga standardhälbega 0.1 m.  

 
Kalibreerimine leketega 
Ideaalolukorda, kus veevõrku on vaja kalibreerida vaid füüsikaliste parameetrite vastu (nagu näiteks 
toru karedus) esineb väga harva. Peamiselt vaid uute torustike juures. Alati on veevõrgus olemas ka 
mingid kaod ning need on teadmata asukohtades. See tähendab, et meie kalibreerimise probleem 
laieneb ühe muutuja võrra. Me peame kao paigutama selle tegelikku punkti ning kalibreerima seejärel 
võrgumudeli uuesti. Loomulikult peab meil olema sellistel puhkudel rohkem infot veevõrgumudeli 
kohta.  

Esmalt on üldjuhul teada veevõrgus torude karakteristikud, mis aitavad meil määrata paremini 
kareduse lähtepunkti või vahemiku. Siiani alustasime uute torude karedusest ning samm-samm haaval 
lisasime karedust. Nüüd peame me samal ajal kindlustama ka, et kaod oleks veevõrku lisatud.  

Näide anytown_lekked_start.net sisaldab ühte leket. Selle asukoht pole teada. Samas on meil olemas 
mõõtmisandmed meile juba tuttavatest punktidest. Eesmärk on kalibreerida võrk nii, et lekke asukoht 
ning suurus tuleks sellega võimalikult täpselt välja.  

Kui eelnevates ülesannetes oli protseduuri suhteliselt lihtne läbi viia, ning põhimõtteliselt võiks seda 
teha ka käsitsi (siiski vaid lihtsate võrkude korral), siis siinses ülesandes on seda märksa raskem teha. 
Seetõttu on välja töötatud erinevaid algoritme, mis automaatselt analüüsivad võrku teatud meetodiga 
nii, et lõpptulemusena oleks rõhkude vahe (mõõdetud ning arvutusliku tulemi) minimaalne. Olgu 
veelkord öeldud, et selliseid sobivaid lõpplahendeid võib olla mitmeid ja mitmeid. Algoritmidest 
levinumad, mida veevõrgukalibreerimise juures kasutatakse on Genetic Algorithm ning Levenberg-
Marquardt. Hiljuti on lisandunud ka SCEM-UA (Shuffled Complex Evolution Metropolis) algoritm. 

Meile on oluline esmalt teadvustada probleemi olemust. Ning lahendame ülesande teatud juhtnööre 
kasutades. Mõõtmistulemuste juures kasutame seekord jällegi perfektseid andmeid.  

Ava mudel, käivita ning vaata kalibreerimise andmeid (kalibreerimise fail sedakorda 
mootmised_lekkega.dat).  



WATER | Veevõrgu kalibreerimine (EPANET) | Raido Puust | 2024 8/12 
 

 

Graafikult on näha, et kõik arvutuslikud tulemid on suuremad ning seetõttu tuleb rõhukadusid 
suurendada (NB! ka lekked suurendavad rõhukadusid). Esmalt proovime parandada tulemit toru 
kareduste muutmise teel. Me eeldame, et kõikide torude karedused on ühed ja samad ning paneme 
uueks toru kareduseks 3 mm. 

 

Näeme, et vahe mõõdetud ning arvutatud rõhu vahel kahaneb märgatavalt. Lisame kareduseks nüüd 
5 mm. 

 

Tulemus on paranenud veelgi. Lisame kareduseks nüüd 6 mm. 
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Ehkki tulem veelgi paranenud, peaks meid tegema veidi ettevaatlikumaks asjaolu, et punktide 40 ning 
90 juures on arvutatud rõhk juba väiksem (ennist oli kogu aeg suurem) mõõdetud rõhust (jah punkti 
90 juures on tegemist peaaegu sama väärtusega). Samas, kui punktide 120 ning 140 juures on vahed 
endiselt märksa suuremad. Ühe puntki juures koguni veel 5 m. Siinkohal peakski esialgu piirduma 
torukareduste muutmisega (jääb 6 mm peale) ning asume lekke otsimisele (sest toru kareduste 
suurendamine vähendab küll punktide 120 ning 140 vahesid, kuid samas suurenevad punktide 40 ning 
90 vahed teisele poole).  

Lekkeid veevõrgus võib modelleerida väga erinevate valemite abil. Meie siinkohal ei hakka vaatlema 
erinevaid lekke mudeleid, vaid kasutame kõige levinumat mudelit, mis on kasutusel ka EPANET 
tarkvaras. Teooriatundidest peaks olema tuttav, et lekked on seda suuremad, mida suurem on 
tööpunkti rõhk. Lekke sõltuvus rõhust on üleskirjutatav alljärgneval viisil: 

αHKQLEKE ⋅=     (1) 

Valemis (1) tähistavad = lekke vooluhulk (l/s); K = teatud koondparameeter, mis kaasab endas lekke 
ava ning suuruse parameetrit (üldjuhul kalibreeritaksegi seda suurust veevõrgus, seda muidugi juhul 
kui lekke valemina kasutatakse valemit (1)); H = rõhk lekke punktis; α = lekke eksponent.  
 
EPANET tarkvaras on vastavatele suurustele järgmised parameetrid: 

α  Emitter Exponent (menüüst Project > Defaults... : Hydraulics). Vaikimisi väärtusel 0.5 
kõikide lekkepunktide kohta. Tegemist on globaalse väärtusega.  

K  Emitter Coefficient (sõlmpunkti parameeter, võib olla iga sõlme/lekke kirjeldamiseks olla 
erinev).  

H  Pressure (sõlme arvutuslik parameeter).   
Actual Demand (sõlme arvutuslik parameeter, mis sisaldab nii lekke vooluhulka kui ka 
tarbimise vooluhulka antud ajahetkel).  

Meie ülesanne on muuta väärtust Emitter Coefficient.  

Vaatame uuesti viimast kalibreerimise tulemit esitavat tabelit. Me näeme, et sõlmede 120 ning 140 
juures rõhkude vahed vägagi erinevad sellest, mis võrgu ülemistes mõõtepunktides. Sellest võiks 
järeldada (kuna tegemist on suhteliselt lihtsa võrguga, ning meil on teada ka, et võrgus esineb vaid 
ühes punktis leke), et leke esineb punktide 120 ning 140 läheduses.  

Lekke juures on teada asjaolu, et see mõjutab veevõrgu rõhkusid vaid selle lähiümbruses. Just seetõttu, 
ei erine võrgu ülemises osas ka rõhud nii palju kui alumises osas, kust eeldatavasti leket otsime. 
Esmapilgul võiks arvata, et leke on sõlmes 100, 110, 120, 130, 140, 150, 160 või 170.  
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Kuidas teame, mis suurusega leke võrgus eksisteerib? Eeldades, et meie süsteemis on vaid lekked, siis 
saame ligikaudse lekke suuruse teada, kui arvestame veevõrku sissepumbatavat veehulka ning 
veevõrgus tarbitavat veehulka. Nende vahe peaks olema pluss märgiga, sest pumpla peab 
kompenseerima ka lekked veevõrgus. Samas raskendab seda asjaolu, et meie veevõrgumudelis 
kompenseerivad mahutid osaliselt lisavooluhulkasid ning see ei pruugi nii selgepiiriliselt välja tulla.  

Tagasi lekke punkti määramise juurde. Me võime välistada eelpooltoodud punktidest lekke asukohana 
100, 140, 150. Kuna need asuvad liiga lähedale mõõtepunktidele 90 ning 140 ning erinevus mõõdetava 
ning arvutusliku rõhu vahel peaks sellisel juhul ka neis kõige rohkem kajastuma. Meil kajastub see aga 
punktis 120 kõige rohkem.  

Meil on nüüd järgi veel punktid 110, 120, 130, 160, 170. Punktid 110 ning 120 võib välja jätta asjaoludel, 
et need on liiga kaugel mõõtepunktist 140 ning leke ei suudaks nii suurt mõju avaldada nimetatud 
punktile. Jäävad järgi kolm punkti 130, 160, 170.  

Valime koefitsiendiks 5 ning vaatame, mis tulemi saame, kui lisame selle üksikult igasse sõlme. Teeme 
arvutuse.  

 

Sõlm 130. K = 5. 

 

Sõlm 160. K = 5.  
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Sõlm 170. K = 5. 

Näeme, et parima tulemuse saame siis, kui loeme lekkesõlmeks sõlme 170. Suurendame lekke 
väärtust. Olgu K = 10. 

 

Sõlm 170. K = 10.  

Tulemus on märksa parem. Seega suurendame lekke suurust veelgi. Nüüd väärtusele 11. 

 

Sõlm 170. K = 11. 

Näeme, et tulemus läheb kehvemaks. Seega ei tohiks lekke suurust enam suurendada. Taastame 
eelmise väärtuse ning vähendame lisaks toru karedust väärtusele 5 mm.  
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Sõlm 170. K = 10. Toru karedused = 5 mm. 

Näeme, et tegemist on suurepärase täpsusega. Oleme mudeli kalibreerinud ning lekke asukoha ka 
kindlaks teinud. Lekke suuruse saame teada arvuliselt kui võtame sõlmpunkti väljal Actual Demand 
maha hetke tarbimise.  

NB! Tegemist oli siiski lihtsa ülesandega. Tähele tasub pöörata ka sellele kus me tegime lõpliku valiku 
punktide 130, 160 ning 170 vahel. Nimelt oli ka punkt 130 piisavalt väikeste vahedega (üsna sarnane 
puntkile 170). Meie valisime punkti 170 seetõttu, et punktide 120 ning 170 summaarne väärtus veerus 
Mean Error oli oluliselt väiksem kui punkti 130 korral. Aga me oleksime jõudnud nii et naa punktini 
170, sest lekke suurendamine punktis 130 oleks vahed viinud märksa suuremateks ning me oleks aru 
saanud, et tegemist pole õige lekke asukohaga.  
 

 

Mõned märkused, miks tegelikkuses kalibreerimine nii lihtne pole:  

• Iga toru võib omada oma enda karedust. Mitte ei muudeta neid kõiki korraga. Üsna 
sagedasti grupeeritakse torud teatud omaduste järgi (paigaldusaasta, purunemiste arv, 
läbimõõt jne) nii, et selle grupi piires muudetakse toru karedust ühtlaselt. See lihtsustab 
mõnevõrra kalibreerimist.  

• Lekked võivad asuda korraga väga mitmes punktis. Tegemist võib olla väga erinevate 
lekete suurustega.  

• Reaalses võrgus esinevad alati mõõtmisvead ja/või on elementidele sisestatud valed 
andmed. Seda asjaolu tuleks samuti arvestada.  

• Veevõrgus ei esine mitte ainult lekked aga ka arvestamata tarbimised, mis käituvad 
ööpäeva lõikes samamoodi kui arvestatud tarbimised – teatud graafiku alusel. 
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